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Linden Bay Romance 
 

Manuscript Preparation Guide for Authors 
 
Welcome to Linden Bay Romance!  
 
Below  are  preparation  guidelines  to  use  when 
submitting a manuscript for consideration. They include 
a checklist of common content edit problems, an outline 
of  basic  grammar  and  punctuation  rules,  and  a 
formatting  guide.  Please  use  these  to  check  over  your 
manuscript prior to submitting  in order to give you the 
best possible chance of a positive reply. 
 
Punctuation and grammar rules are constantly changing, 
now  more  quickly  than  ever  with  the  advent  of 
electronic  communication. Much of what we  learned  in 
school  no  longer  applies  and  has  been  updated  with 
more  recent  standards.  To  remain  current,  the 
punctuation  and  grammar  standards  used  by  LBR’s 
Editorial  Department  are  derived  from  this  year’s 
edition  of  The  Chicago  Manual  of  Style.  LBR  authors 
should make themselves familiar with CMS standards by 
visiting: http://www.chicagomanualofstyle.org 
 
Content Edit Checklist: 
 

• Continuity problems       
  Such  as:  he  snuffed  out  his  cigarette  on 
page  11  but  took  another  drag  on  page  13 
without having lit another one. 

• Exposition       
  Show through action who the characters 
are  and  how  they  feel,  don’t  tell  us  through 
description 
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• Info­dump         
  Feed  us  information  slowly  and  in 
natural ways,  don’t  dump multiple  details  all  at 
once  just  to  get  the  background  across  to  the 
reader. 

• Passive voice and overuse of the verb ‘was’ 
  Passive voice is a sentence where 
something is done to someone (She was hit by 
him) vs. having someone do the action (He hit 
her). Often this uses the ‘ing’ form of the verb, or 
involves the verb ‘was’. ‘The door smacked her in 
the face’ is preferred over ‘She was smacked in 
the face by the door’. Passive voice should be 
avoided whenever possible.   

• Mixing or overuse of pronouns 
  Using  a  male  pronoun  (he)  when 
referring  to  a  woman,  or  using  too  many 
pronouns  (particularly  in  situations  where  the 
reference  isn’t  clear  as  to  who  the  pronoun  is 
representing). 

• Mixing tenses 
• Singular noun/verb with plural verb/noun 
• Lack of variation in word choice 
• Lack of sentence rhythm variation 
• Overuse of Proper Names 
• Overuse of dialogue tags     

  Particularly  in  a  conversation  between 
two  people  where  the  reader  can  easily  infer 
which person is talking when the speech pattern 
is back and forth. Avoid use of  “said she” rather 
than “she said”. 

• Overuse of “just”, “even”, “that”, and “very”. 
• Abrupt or repeated change in POV 
• Overuse  of  adverbs  to  describe  the  action 

rather than selection of a more succinct verb.
  ‘He  stumbled  across  the  street’  is 
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preferred  over  ‘He  walked  clumsily  across  the 
street’. 

• Overuse of conjunctions.        
Use  more  complex  sentence  construction  in 
blending  sentences,  using  conjunctions  only 
when truly needed. 

• Which vs. That:   Use “which” plus two commas 
to  set  off  nonrestrictive  clauses;  use  “that”  to 
introduce a restrictive clause.     
  Pizza  that  is  less  than  an  inch  deep  just 
isn’t Chicago style.       
  Pizza, which is a favorite of mine, can be 
bad for my waistline. 

• Like  vs.  As  If  or  As:    The  word  “like”  is  an 
adjectival preposition that is followed by a noun 
or pronoun (the person in that old portrait looks 
like me).  It  should not be used as a  conjunction 
to connect clauses and is often seen so when “as” 
or “as if” is the proper term. Try inserting “as” or 
“‘as if” instead of “like” to determine if it is used 
correctly  –  if  the  insertion  makes  sense,  then 
“like” is not being correctly used.   
  ‘It  happened  just  as  I  said  it  would’  is 
correct,  whereas  ‘It  happened  just  like  I  said  it 
would’ is not. 

 
Basic Punctuation and Grammar Rules: 
 
Spacing:    One  space  after  periods  and  colons  is  now 
preferable, two spaces is acceptable if used consistently 
throughout the manuscript. 
 
Sentence  Fragments:    Previously  considered 
technically  incorrect,  sentence  fragments  can  be  used 
sparingly today in prose to indicate a strong emotion or 
extremely emotional scene. Overuse can be corrected by 
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linking the fragment to the sentence before or after with 
a conjunction or comma. 
 
Relationship  Titles:    When  a  title  that  indicates 
relationship is used as a reference, it should be in lower 
case. When used in place of a proper name, it should be 
in upper case. 
My mom said no. But Dad said yes. 
 
Terms of Endearment:   Always lower case, even when 
used in place of a proper name. 
 
Dreams/flashbacks/thoughts:    Italicized  with  no 
special spacing if a short sentence or two. If longer than 
two short sentences,  these should be  italicized and  in a 
separate paragraph. 
 
Book Titles, TV Shows, Magazines, Plays, etc:  Italics 
 
Hyphens/EN Dashes:  Hyphens are used to connect two 
things  that  are  intimately  related  and  functioning  as  a 
single concept or word, such as multi‐purpose, toll‐free, 
two‐thirds,  etc.  They  are  also  commonly  used  now 
instead of  the EN dash  (a  longer hyphen not as  long as 
the EM dash), and are used for ranges and to connect a 
prefix  to  a  proper  open  compound,  such  as  a  May‐
September issue of a magazine, or pre‐World War II. 
 
EM  Dashes:    Used  to  indicate  a  cut‐off  sentence  in 
dialogue  or  to  set  off  a  change  of  thought  similar  to 
parentheses—such  as  I  have  done  here.  No more  than 
TWO should be used in a sentence; if this occurs, change 
one set to parentheses. Should be used sparingly in any 
manuscript.  EM  dashes  should  not  be  used  in 
interrupted  speech  that  continues;  ellipses  are 
preferred—see below.  PCs  can produce  an EM dash by 
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holding  down  the  ALT  key  and  typing  0151  on  their 
numbers pad on the right of the keyboard. If you do not 
have  this  capability,  use  two  hyphens  (‐‐)  and  we  will 
change to the EM dash. 
“But I don’t think—," she began, but he cut her short. 
 
Ellipses:    Used  to  indicate  short  pauses  or  stuttering 
speech  patterns.  When  ellipses  are  used  within  a 
sentence, no  spaces  are  required before or  after. When 
used at the end of a sentence or piece of dialogue, do not 
use  a  period  or  other  punctuation  mark  to  end  the 
sentence, simply space before starting the next sentence. 
Should be used sparingly in any manuscript. 
He  didn’t  think  that  was  correct,  but…  Now  he  knew 
better. 
“No, that can’t…I mean, really…you can’t be serious…it’s 
just…” he said. 
 
Semi­colons:    Used  to  separate  two  independent 
clauses instead of a conjunction; they are used instead of 
commas  when  each  phrase  could  stand  alone  as  a 
sentence. The use of  the semi‐colon, particularly within 
dialogue,  is used  less and  less often on modern writing 
and  can  seem  jarring  to  the  reader.  If  possible,  try  to 
avoid them. 
 
Commas:   Supposed to be used to make the meaning of 
a sentence clear to the reader and should therefore only 
be used when necessary. Often, use of a comma or not is 
a  judgment  call,  and  in  these  cases  the  editor  should 
allow the decision to remain with the author unless the 
sentence is confusing. 
 
1­Commas  in a Series:   The CMS  favors continued use 
of  the  comma  in  serials  of  three  or more  including  the 
final coma before the conjunction in order to clarify the 
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continuation  of  the  series  (some  schools  of  thought  no 
longer require this). Commas are not needed in a series 
if all elements are  joined by conjunctions. A semi‐colon 
instead  of  a  comma  should  separate  long  sentences 
containing series that have internal punctuation. 
The shirt had red, blue, and white stripes. 
Dogs, cats, birds, etc., all must be in cages. 
Was it Johnson or Black or Kennedy who said that? 
The  defendant,  in  an  attempt  to  mitigate  his  sentence, 
pleaded  that  he  had  recently,  and  quite  unexpectedly, 
lost  his  job;  that  his  landlady—whom,  incidentally,  he 
had  once  saved  from  attack—had  threatened  him with 
eviction; and that he had not eaten for several days. 
 
2­Commas  and  Introductory Words  or  Phrases:    An 
adverbial  or  participial  phrase  at  the  beginning  of  a 
sentence  requires  a  comma  unless  it  is  less  than  three 
words  in  length.  A  single  word  or  phrase  of  less  than 
three  words  does  not  require  a  comma  unless  the 
meaning is unclear without one or unless it is “Oh”, “Ah”, 
“No”, or a direct address. 
Having eaten the cat’s dinner, Fido proceeded to eat his 
own. 
On Tuesday the gang went to the movies. 
Before eating,  the gang all met at  Jim’s house.  (clarifies 
meaning) 
Oh, I see what you mean now! 
No, that is not what I meant. 
Sir, please come with me. 
 
3­Commas and Interjections or Descriptive Phrases:  
Used  to  set  off  elements  when  parentheses  are  too 
strong  and  there  are  no  other  punctuation  within  the 
element,  but  not  if  the  adverb  is  essential  to  the 
meaning. Likewise, a descriptive phrase that is essential 
(restrictive)  to  the  meaning  of  the  noun  is  not  set  off 
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with commas, but a nonessential (nonrestrictive) phrase 
is. 
This, indeed, is what we thought would happen. 
The report was, to say the least, overwhelming. 
She knew that, in the end, truth would prevail. 
The storehouse was indeed necessary. 
Two students cheated and were therefore expelled. 
Come on in (quietly, please!) and take a seat. 
The woman wearing a red coat is my sister. 
My  sister,  wearing  a  red  coat,  waved  to  me  from  the 
driveway. 
 
4­Commas  and  Independent  Clauses:    Independent 
clauses joined by conjunctions such as and, but, or, so, or 
yet  require  commas  unless  they  are  very  short  and 
closely connected. A comma is not used between two or 
more verbs having the same subject unless required for 
clarification. 
Everyone present was startled, and one man fainted 
Do we want to go to the movies, or stay home and watch 
television? 
Timothy played the guitar and Betty sang. 
She had gone to town and purchased the flowers. 
 
5­Commas  and  Dependent  Clauses:    A  dependent 
clause that precedes a main clause requires a comma. A 
dependent  clause  that  follows  a  main  clause  does  not 
require a comma  if  it  is essential  to  the meaning of  the 
main clause. 
If you accept our conditions, we shall sign the document. 
We will sign the document if you accept our conditions. 
He ought to be promoted, if you ask me. 
 
6­Commas  and  Relative  Clauses  or  Appositives:    If 
not  essential  to  the  meaning  of  the  sentence,  commas 
should be used. 
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The  report  that  the  committee  submitted  was  well 
documented. 
The  report,  submitted  by  the  committee,  was  well 
documented. 
My older sister, Betty, taught me to play piano. 
My  older  sister  Susan  taught  me  to  cook.  (I  have  two 
sisters) 
 
Manuscript Formatting: 
 
‐Spellchecker should be on United States English. 
 
‐ Manuscripts must be submitted using Microsoft Word. 
 

• File>Page  Set  Up>Paper  Size>Manage  Custom  ‐ 
Create  5.00  in  width  X  8.00  in  height  and  .50 
margins top, bottom, right and left 

• Format>Font ‐ Times New Roman 11 
• Format>Paragraph>  ‐  Alignment  =  Justified, 

Indentation = Left/Right  0's Special = "first line" 
@  .25  in,  Spacing  =  Before/After  0's  with  Line 
Spacing @ "single". (Note: If your novel is under 
30,000 set line spacing on “1.5”) 

• Format>Document ‐ Select "Mirror Margins", top 
@ .75 in, bottom @ 50 in, inside @ .75 in, outside 
@ .50 in (Note: If your novel exceeds 200 pages 
then  Edit>select  all>Format>Document  and 
reset the inside to .88 in) 

 
‐The  first page should have  the  title of  the work on  the 
fifth  line  in  caps  centered  and  in  italics  Times  New 
Roman 16 pt font. 
 
‐The following line should contain the author's name in 
caps centered and in italics Times New Roman 12 pt font 
. 
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‐Three  blank  pages  should  follow.  If  the  manuscript  is 
going to contain a dedication, insert it into the second of 
these three blank pages. 
 
‐Chapter headings should be in bold Times New Roman 
12  pt  font  and  left  justified.  If  there  is  a  secondary 
chapter  heading,  i.e.  January  1,  2006,  that  should  be 
directly  underneath,  left  justified,  italics  Times  New 
Romance 11 pt font. 
 
‐The  first  paragraph  of  each  chapter  should  be  left 
justified with no indent. 
 
‐Insert  a  page break  at  the  end of  each  chapter  so  that 
each new chapter is forces to the top of the next page. 
 
‐Scene breaks should be represented by a centered "~". 
 
‐EM dashes (—) should not be represented by a double 
hyphen. 
 
‐Elipses  should  have  no  spaces  in  between  and  be 
represented by three dots (…) 
 
‐At  the  end  of  the  book  the  words  "The  End"  should 
appear followed by a page break. 
 
‐The  last  4  pages  should  be  left  blank  and  should  be 
created using page breaks. 
 
See sample below: 
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Forbidden: The Revolution 

 

 
 
 

 
 
 
To my son Max, who suddenly has become taller, and is 

sometimes wiser, than I am. Chase your dreams. Follow 
your heart. Remember to floss. 



 

 



 
 
 
 
 
 

Chapter One 
 

If I were to be totally honest I’d tell you that the moment I 
laid eyes on her, I knew I was in trouble. What’s worse, I 
knew that there was absolutely nothing I could do to save 
myself. 

There she was, standing on top of what was to become 
my desk, hanging a sign on the wall above it that said 
Welcome Dell. She was wearing brown patent leather high-
heeled shoes and was reaching up on tiptoe. The calves of 
her shapely legs were flexed, well toned, and they acted like 
a homing beacon—sending a signal that went straight to my 
cock. 

I’d never before confused work with anything personal. 
So why was I here now? Two words. My father. 

Like most men in their mid-twenties, I’m determined to 
make it on my own. I want to lead my life the way I want, 
choose my own career path, make my own decisions. But 
I’m not like most men. I’m a vampire. Does my boss know 
that? Hell, no. But I can guarantee you that someone at the 
branch knows, someone high up, or else dear old Dad 
wouldn’t have been able to pull these strings. And now I’m 
stuck. There’s no way that I can turn down this assignment 
without causing undue attention to myself.  
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She stepped back to admire her handiwork, the heels of 
her shoes resting precariously at the edge of the desk. She 
stood there for a minute, her hands on her hips and her full 
lips pursed into a delicious pout that told me that she wasn’t 
quite satisfied. 

A long strand of her brown hair had escaped what had 
once been a neat chignon. Just as she lifted her arm to tuck 
it back into place my phone rang.  

She turned quickly in my direction, too quickly, 
throwing her arms out in an attempt to regain her own 
balance. But she was too late and falling too fast. Like the 
chivalrous guy that I am, I was there to catch her. For one 
long, endless moment we silently stared into one another’s 
eyes. Hers were a brilliant green, amazingly inviting, and 
surrounded by thick dark lashes. It was like falling into 
springtime. 

She blinked, slowly. 
I glanced up at the sign. 
“You the welcome wagon?” I asked her. 
She reached down and fingered the badge that was 

clipped to my collar, lifting up the edge and turning it 
towards her so that she could read it. 

“Agent Renfield,” she said. “You’ve got some fast 
reflexes there. I’m Alex, your new partner. I think it’s safe 
to put me down, now.” 

“Right.” 
The instant that Alexandria Sanchez’s feet touched the 

floor, my cell phone went off again. I didn’t have to check 
to see who it was, the ring tone told me that. Dad was 
nothing if not persistent. 

“Excuse me,” I told Alex before slipping out of the 
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office. 
“How the hell did you pull this off?” I growled into the 

phone.  
“Pull what off?” my father replied innocently. He knew 

damned well what I was referring to.  
“Come on, Dad. Don’t bullshit me. I told you that I 

didn’t want to get involved,” I reminded him. 
“Out of our entire network of operatives, you make the 

most sense. All it took was getting you a transfer from 
Chicago to LA. It would have been far more complicated if 
we had to get someone into the Agency to begin with and 
start from scratch. You’re a natural for this assignment, 
Dell. We’re pretty sure it’s her. We’ll do a DNA check, get 
the confirmation, then—” 

“I’m not one of your operatives,” I hissed. 
As if being a vampire wasn’t enough to have to 

overcome, I also had the legacy of being the son of Byron 
Renfield. Not that anyone outside of his inner circle would 
know that. According to clan folklore Byron was the 
youngest of the Dominie, an elite group of vampires 
empowered by Cain, our prophet. The Dominie were 
supposedly destined to lead us all into redemption. They 
were holy men, they didn’t mate, and they certainly didn’t 
have kids. None of the good “practicing” vampires did, 
though those were becoming fewer and fewer with each 
passing year. It was a trend that my father, as the leader of a 
quietly subversive revolution, had been working towards  
my entire life.  

Dad was succeeding, too. Gradually, little by little, he 
was changing the social and economic structure within the 
vampire world. My father was a brilliant strategist and the 
smartest man I knew. I had no doubt that within my lifetime 
his goal to mainstream our race, to integrate us into the 
human world, would be realized. It wasn’t his goal that I 
disagreed with, it was his methods. They were simply 
taking too long. I wanted to be a part of the real world now. 
That’s why I left home. Not because I didn’t believe in what 
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he was doing. I did believe in it. It made sense, his carefully 
crafted plan. But it required patience and that wasn’t one of 
my virtues. I wanted to taste it now…real freedom.  

I imagined him pacing back and forth, wearing down 
the carpet in his neat and tidy office.  

“No, you’re not,” he acknowledged. “You’re not one of 
my operatives. But you understand how important this is, 
Dell. This is personal.” 

 


